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             YORKTOWN HIGH SCHOOL  

                   Digital Photography I 
                                Mr. Fleischer  

                  Competency Checklist 
 

 

FIRST QUARTER COMPETENCIES 
 

      ATTENDANCE & SAFETY 
r  r  r  r  r   Understand the importance of attendance as relates to class performance. 
r  r  r  r  r   Understand the attendance rules of Yorktown High School. 
r  r  r  r  r   React properly to classroom and building emergencies. 
r  r  r  r  r   Handle cutting tools carefully. 
r  r  r  r  r   Understand safety sheet, class rules, and setting up CBE. 
       
      TOOLS & INSTRUMENTS 
r  r  r  r  r   Demonstrate proper use of T-Square. 
r  r  r  r  r   Demonstrate proper use of triangles. 
r  r  r  r  r   Demonstrate proper use of measuring device. 
       
      I.       Digital Single Lens Reflex Camera 
r  r  r  r  r   1.1    Understand the anatomy of a digital camera. 
r  r  r  r  r   1.2    Locate the CMOS sensor or shutter within a film/digital camera. 
r  r  r  r  r   1.3    Understand that all five (5) megapixels cameras are not the same quality. 
r  r  r  r  r   1.4    Students will photograph with a cell phone. 
r  r  r  r  r   1.5    Students will demonstrate taking a digital photo with auto mode and manual  

   mode with a DSLR. 
r  r  r  r  r   1.6    Students will demonstrate lens aperture to create various depth of fields  

  within a photograph. 
r  r  r  r  r   1.7   Students will demonstrate various shutter speeds to create photographs with  

 various amounts of motion. 
r  r  r  r  r   1.8   Students will photograph with electronic flash on digital camera using TTL 

  and manual. 
r  r  r  r  r   1.9    Students will photograph outside with fill flash, underexpose background and 
r  r  r  r  r   1.10  Students will recharge batteries for digital camera. 
r  r  r  r  r   1.11  Students will research underlying principles of technology. 
       
      2.     Camera Lens 
r  r  r  r  r   2.1   Define wide-angle telephoto normal macro-lens.  Create photos over expose  

         flash output that clearly Illustrate the differences of the above lenses. 
r  r  r  r  r   2.2   Use macro-lens create a photo of an object that is smaller then a quarter that  

        fills the frame of your film/digital camera. 
r  r  r  r  r   2.3   Use optical telephoto lens, photograph person or object that is far away, so it  

        appears closer in the lens. 
r  r  r  r  r   2.4    Use digital telephoto lens that photographs an object at 11X. 
r  r  r  r  r   2.5    Use wide-angle lens, photograph an object where the camera is inches from  

         subject to show wide-angle distortion. 
r  r  r  r  r   2.6    Use wide-angle lens, photograph an object where the camera is at least ten  

         feet from the subject to show wide angle coverage. 
r  r  r  r  r   2.7    Use normal lens, photograph an object a few feet away, zoom lens so this  

   object appears the same size on view finder as it appears with one eye  
   closed. 

       
      3.      Range-Finder Digital Camera 
r  r  r  r  r   3.1    Understand how to turn camera on and off. 
r  r  r  r  r   3.2    Understand how to remove and install media card in camera or load film. 



 
r  r  r  r  r   3.3    Students are able to control zoom for different effects. 
r  r  r  r  r   3.4    Understand all the various models of camera. 
r  r  r  r  r   3.5    Understand how to review photos after they are taken for digital. 
r  r  r  r  r   3.6    Understand how to activate macro and flash features. 
r  r  r  r  r   3.7    Understand how to change resolution, ISO, shutter speed and aperture  

         settings for controlled effects. 
r  r  r  r  r   3.8    Understand how to erase and rotate photos within the camera for digital. 
r  r  r  r  r   3.9    Students can demonstrate how to clean a camera lens properly. 
       
      4.      Film/Digital Imaging Work Station 
r  r  r  r  r   4.1    Students can demonstrate turning on and logging into their individual  

         accounts. 
r  r  r  r  r   4.2    Identify photo snap server icon on desktop of work station. 
r  r  r  r  r   4.3    Retrieve photos from snap server and copy images to my documents folder. 
r  r  r  r  r   4.4    Demonstrate opening images within Adobe PhotoShop CS5 
r  r  r  r  r   4.5    Students will demonstrate how to burn a personal CD of their photographs. 
r  r  r  r  r   4.6    Students will be able to adjust 17” Flat Panel monitor for Vertical and  

 Horizontal View. 
r  r  r  r  r   4.7    Students will be able to properly log off account. 
       
      5.      Adobe PhotoShop CS5 

r  r  r  r  r   5.1    Students will explore the History of Adobe PhotoShop. 
r  r  r  r  r   5.2    Students will be able to locate program on desktop and open. 
r  r  r  r  r   5.3    Students will be able to locate tool bar, Layer Menu and History Menu and  

         properly use. 
r  r  r  r  r   5.4    Students will demonstrate proper lasso and masking techniques. 
r  r  r  r  r   5.5    Students will understand how to adjust size and resolution of photos. 
r  r  r  r  r   5.6    Students will be able to combine two various images into one photo. 
r  r  r  r  r   5.7    Students will be able to use stamp tool, zoom tool, healing tool, paint brush,  

         eraser gradient tool, and drag tool. 
r  r  r  r  r   5.8    Students will demonstrate how to save their image into the “my documents  

         folder”. 
r  r  r  r  r   5.9   Students will scan the favorite darkroom print onto the scanner, and  

 Import into PhotoShop CS5 to enhance. 
       
      6.      Film/Digital Manipulation 
r  r  r  r  r   6.1    Students will be photographed in studio by another student acting out a pose 

         to be restored into a photo from Washington DC. 
r  r  r  r  r   6.2  Students will either shrink or enlarge themselves to create a photo that has  

         new meaning. 
r  r  r  r  r   6.3   Students will shrink or enlarge themselves within a photo from the zoo photo 

         folder. 
r  r  r  r  r   6.4 Students will open hippo photo and use clone stamp to remove the bars and  

        free the Hippo. 
r  r  r  r  r   6.5    Students will also use content aware scale. 
r  r  r  r  r   6.6    Students will alter the appearance of all the spots on the giraffe. 
       
      SECOND QUARTER COMPETENCIES 

       
      7.      Digital Alteration 
r  r  r  r  r   7.1    Students will locate, select and apply various filters to one photograph of  

          their choice. 
r  r  r  r  r   7.2    Students will demonstrate proper archival matting of a photograph for  

          exhibition. 
r  r  r  r  r   7.3    Students will allow a minimum of one full class period for post production of  

         their creative digital photographs. 
r  r  r  r  r   7.4    Assignment 1—Create a photo for the following statement:  “You won’t  

         believe where I saw an animal”, transform merge multiple images. 
r  r  r  r  r   7.5     Assignment 2—Create a photo for the following statement:  “It was the  

   (smallest or largest) animal I have ever seen” and transform merge multiple  
   images. 

       



r  r  r  r  r   7.6    Student will take a digital photo outside and create the effect of "Make It  
         Snow".  

r  r  r  r  r   7.7   Students will take a digital photo outside which included people and  
         "Make It Snow, not on people". 

r  r  r  r  r   7.8   Students photograph in the environment, and also have a photo taken of  
  then in the same lighting.  Students then combine the two photos, and using 
  Transform will create "The Incredible Shrinking Person".  Use Refine Edge 

r  r  r  r  r   7.9   Students will master duplicating layers with Transform by creating a  
  shadow effect, and using Opacity in the layers box to lighten the shadow of  
  the student. 

r  r  r  r  r   7.10   Students will photograph an object on the studio table top using 45
o
 

  lighting.  Students will be photographed against white wall with 45
o 
light 

  and layer and shrink themselves to interact with table-top photo. 
r  r  r  r  r   7.11   Students will create a reflection of themselves on the tabletop.  Students 

  will duplicate their layers, and using Transform to create an inverted  
  reflection of themselves with Adjustment of Opacity. 

r  r  r  r  r   7.12   Students will create an Ipod commercial using a studio photo of  
  themselves.  Students will master of Magic Wand tool and Edit → Fill     
  to create a silhouette of themselves.  Students will use Transform and 
  create a shadow of themselves to create depth in the 2-D photo.  

r  r  r  r  r   7.13   Students will master the Text tool to place words into their Ipod Commercial 
  assignment. 

       
      8.      Creative Digital Photo 
r  r  r  r  r   8.1    Student will use tools and creative techniques demonstrated thus far and 

 Create a portfolio of their creative vision. 
r  r  r  r  r   8.2    This quarter you have had the option of doing extra credit by solving the  

  weekly Washington Post magazine, second chance photos. 
r  r  r  r  r   8.3    Using the tools and technique we have demonstrated in class this first  

 quarter create your own second chance photograph for your classmates  
 to solve. 

r  r  r  r  r   8.4    Students will create a New Background at 300 dpi at 8 x 10 inches. 
r  r  r  r  r   8.5    Students will photograph indoor or outdoor scenery that has a lot of details. 
r  r  r  r  r   8.6    Students will open a photograph and resize it to 300 dpi, 4 x 5 inches and  

         place on background. 
r  r  r  r  r   8.7   Students will duplicate their photograph and place it next to the original 

 photograph of scenery. 
r  r  r  r  r   8.8   Make at least 7 changes to one photograph to include the following: 

 Color change, resize, delete objects on letters, add or change letters,  
 Incorporate Lasso or Masking tool, Eye Dropper, Eraser, Clone tool,  
 Move tool, and Magnifier to assist you in your production of your final 
 photo. 

r  r  r  r  r   8.9   For extra credit add the following (5) objects to your second 6-lance photo: 
1) Object from your pocket. 
2) One of your shoes 
3) Object in classroom 
4) Object from parking lot 
5) Object from commons Area 

r  r  r  r  r   8.10   Extra credit to down load your own photos with card reader. 
       
r  r  r  r  r   9.      Photo Studio 
r  r  r  r  r   9.1    Students will demonstrate turning studio flashes on and off. 
r  r  r  r  r   9.2   Students will demonstrate setting up remote sender and receiver with  

         correct channels. 
r  r  r  r  r   9.3   Be able to correct the exposure in the camera. 
r  r  r  r  r   9.4   Be able to hook camera up to TV monitor. 
r  r  r  r  r   9.5   Students will demonstrate 90°, 45°, silhouette, 90° profile with and without  

        fill card. 
r  r  r  r  r   9.6   Plan setting/background, composition, camera angle and camera distance 

        for a simple head and shoulders portrait using a variety of lighting  
        techniques. 

r  r  r  r  r   9.7   Photograph an environmental portrait with film/digital camera. 
r  r  r  r  r   9.8   Explore business practices. 



r  r  r  r  r   9.9    Identify code of ethics for business practices. 
r  r  r  r  r   9.10  Learn how to size an image to fit into the CD case. 
r  r  r  r  r   9.11  Review of good composition including a prop (stuffed animal) Rules of thirds. 
r  r  r  r  r   9.12  Use proper camera angle and soft lighting for children portraits. 
r  r  r  r  r   9.13  Photograph under florescent lighting and then color correct.. 
r  r  r  r  r   9.14  Discuss client’s needs and being professional and meet specific deadlines. 
r  r  r  r  r   9.15  Students will meet a required timeline. 
       
      10.    Competition 
r  r  r  r  r   10.1  Students will create an entry for Regional Scholastic Competition. 
r  r  r  r  r   10.2  Students will create an entry for Regional VICA Competition. 
       
      THIRD QUARTER COMPETENCIES 

 

      11.    Extraction 
r  r  r  r  r   11.1  Students will use Refine Edge to combine two layer into one photo that 

         are from different environments. 
r  r  r  r  r   11.2  Students will isolate a person from one photograph using the Pen tool and  

move the subject to another environment. 
       
      12.    Filters 
r  r  r  r  r   12.1  Students will take one photograph of themselves, and experiment with Filter  

         Gallery Effects. 
r  r  r  r  r   12.2  Students will take one photograph and also create a new background layer 

         with the same DPI.  The image will be dragged to new layer.  (Continued) 
r  r  r  r  r   12.3  Students will duplicate the layer one image, three times and lay the four  

         photos out symmetrically.  (Continued) 
r  r  r  r  r   12.4  Students will filter each new layer with various filter.  (End) 
       
      13.    Cosmetic Retouching 
r  r  r  r  r   13.1  Take head and shoulder portraits using one and two electronic flashes  

with various lighting techniques. 
r  r  r  r  r   13.2  Remove wrinkles and acne from the face. 
r  r  r  r  r   13.3  Change the eye color of one of your portraits. 
r  r  r  r  r   13.4  Change the hair color of a portrait. 
r  r  r  r  r   13.5  Soften the skin from one of your portraits using Lightroom 3 
r  r  r  r  r   13.6  Whiten the teeth from one of your portraits. 
       
      14.    Studio Portraiture 
r  r  r  r  r   14.1  Photograph someone using studio electronic flash against a black back- 

         drop using one at various angles. 
r  r  r  r  r   14.2  Photograph someone against a black back-drop using two electronic studio  

flashes at various angles. 
r  r  r  r  r   14.3  Photograph someone against a black back-drop using one electronic flash  

         with one colored gel. 
r  r  r  r  r   14.4  Photograph someone against a black back-drop using two lights with at  

least one gel. 
r  r  r  r  r   14.5  Photograph using the Boom light. 
      14.6  Photograph with one light at 90

o
 only and also one overhead light only. 

       
      15.   Special Effects with the Digital Camera 
r  r  r  r  r   15.1  Students will use tripod in class studio, with one 45

o
 flash, using a slow  

shutter speed of 15 seconds and small aperture.   
r  r  r  r  r   15.2 Students will attach digital camera to tripod and open shutter, assistant  

         will fire flash while the shutter is open.   
r  r  r  r  r   15.3  Students will have the subject move in different locations to be recorded as  

         a multiple image of the same subject. 
r  r  r  r  r   17.3 Students will create a photo in a darkened studio using a flashlight to paint 

          in the photo. 
r  r  r  r  r   15.5  Students will secure camera on tripod, use long shutter speed with small  

         lens aperture. 
r  r  r  r  r   15.6  Students will use flashlight to paint in object or person.  Experiment with  

         angle of lighting. 
 



r  r  r  r  r   15.7  Photograph a portrait and still life and create two separate images showing 
         Paul Cezanne Technique. 

      15.8 Students will photograph with a digital camera outside and also in 
studio with pocket wizard remotes for studio flash. 

       
      16.    Color Theory 
r  r  r  r  r   16.1  Students will view a color wheel to see the relationship of cool colors, warm  

colors and complimentary colors. 
r  r  r  r  r   16.2  Students will convert a RGB image.  (Continued) 
r  r  r  r  r   16.3  Students will use color theory to lasso certain areas of the photo and use  

Image → Adjust → Variations for new color, using all cool colors with one 
warm color. 

r  r  r  r  r   16.4  Students will use color theory to lasso certain areas of the photo and use →  
Adjust → Variations for new color, using all warm colors with one cool color. 

r  r  r  r  r   16.5  Students will use color theory to lasso certain areas of the photo and use →  
Adjust → Variations for new color, using only complimentary colors. 

r  r  r  r  r   16.6  Students will do one more color theory project using Edit → Fill with various 
opacities.  Students will determine custom color through choosing a 
foreground color. 

      16.7  Students will learn color management for printing. 
       
      17.    Photo restoration of Image 
r  r  r  r  r   17.1  Scan an object.  Is it Art or copy work? 
r  r  r  r  r   17.2  Students will scan an old photo or negative that in damaged and save it at  

         300 dpi. 
r  r  r  r  r   17.3 Students will use Healing tool, Clone tool, Color Balance to recreate a  

         original photo. 
r  r  r  r  r   17.4  Students will scan at 300 dpi various objects. i.e. flower, vegetable, found 

objects with scanner hood open to create a black background. 
r  r  r  r  r   17.5  Students will use levels to color  balance to scanned image with  

          Adjustment Layer and Grey Card. 
r  r  r  r  r   17.6  Students will experiment with Filter, Layers various tools and color to create 

an unique image. 
       
      FOURTH QUARTER COMPETENCIES 

 
      18.    Friend and Family Studio Portraiture 
r  r  r  r  r   18.1  Sign up for studio time and secure a fieldtrip slip for current APS students 

         to be photographed by you 
r  r  r  r  r   18.2  Sign up for studio time and secure a fieldtrip slip for blood related family 

 members to be photographed by you. 
r  r  r  r  r   18.3  Photograph your subject using the posing table. 
r  r  r  r  r   18.4  Photograph your subject using the big red cushioned chair. 
r  r  r  r  r   18.5  Photograph your subject posing at least five people in one image. 
r  r  r  r  r   18.6  Photograph your subject using at least one of our studio props 
r  r  r  r  r   18.7  Photograph your subjects with one light on background, one light on  

subjects at various angles and one light as the main light. 
r  r  r  r  r   18.8  Photograph your subject using at least two different backgrounds. 
r  r  r  r  r   18.9  Do split lighting, Butter Fly Lighting. 
       
      19.    Table top Photograph 
r  r  r  r  r   19.1  Bring in small objects of various textures and shapes and photograph on  

         our light table with film/digital camera. 
r  r  r  r  r   19.2  Use the following lighting techniques with one light and with and without  

         color gel: 
r  r  r  r  r   19.2a Back lighting 
r  r  r  r  r   19.2b Underneath lighting 
r  r  r  r  r   19.2c 90°lighting 
r  r  r  r  r   19.2d Boom overhead light 
r  r  r  r  r   19.3   Photograph your objects using the following lighting techniques with two  

lights with gel: 
r  r  r  r  r   19.3a Back light 
r  r  r  r  r   19.3b Underneath lighting 



r  r  r  r  r   19.3c 90°lighting 
r  r  r  r  r   19.3d Boom overhead lighting 
       
      20.    Digital Rendering Outdoor Photos 
r  r  r  r  r   20.1  Place blurred lighting vignette with an outdoor photo. 
r  r  r  r  r   20.2  Place Focus vignette within an outdoor and also studio photograph. 
       
      21.   Create Your Personal Magazine Cover 
r  r  r  r  r   21.1  Locate cover photo for your magazine. 
r  r  r  r  r   21.2  Find or create title for magazine cover. 
r  r  r  r  r   21.3  Personalize magazine by adding your own text. 
r  r  r  r  r   21.4  For realism add barcode, month and year and price. 
       
      22.   Exploring Careers in Photography 
r  r  r  r  r   22.1  Investigate the history of photography. 
r  r  r  r  r   22.2  Investigate works of photojournalists, photographic artists, and commercial and 

         portrait photographers. 
r  r  r  r  r   22.3  Identify careers available through photography (i.e. retail, portrait, or advertising). 
r  r  r  r  r   22.4  Participate in an internship with a photography-related business. 
r  r  r  r  r   22.5  Explore business practices and identify code of ethics. 
r  r  r  r  r   22.6  Identify code of ethics for business practices. 
r  r  r  r  r   22.7  Write one brief essay that includes your observation of the video at 

         www.virginiaview.org.  Your paper needs to include the following: 
r  r  r  r  r   22.7a Description related fields 
r  r  r  r  r   22.7b Working conditions 
r  r  r  r  r   22.7c Earning benefits 
r  r  r  r  r   22.7d Employment projection 
r  r  r  r  r   22.7e High school subjects 
r  r  r  r  r   22.8   Students will create a full resume. 
       
       
       
       
       
       
       
       
       
       
       


